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SoftPlan 2016 Major Features: Walkthrough Animations
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Walkthrough Animations

With this release, SoftPlan introduces a new feature that allows you to
create custom walkthrough animations by capturing camera movements
you make in the 3D model or in one of SoftPlan’s various 3D views.

These walkthroughs are easy to create, easy to modify and easy to
distribute.

Create compelling videos for your clients or prospective clients.

SoftPlan automatically adjusts the views so you walk up or down stairs.

Each recorded movement becomes a frame on the timeline, building an
animation that can be played back and saved. Add, remove, or modify
frames using the timeline’s editing tools and output settings to create
detailed walkthrough presentations.

You([T)

Post Walkthroughs Directly to YouTube

One of the most problematic concerns for anyone trying to move or share a o
computer animation is the enormous file size. If you are a SoftPlan+ -
subscriber, SoftPlan allows you to add a title and description to an =
animation =
(MTube) Q video and then
upload it
directly to
YouTube to

share with your
colleagues and
clients.

* YouTube
Export is only
available to
SoftPlan+
subscribers.
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SoftPlan 2016 Major Features: 3D

Automatic Presentation Views

With a click of the mouse, you can quickly generate
Presentation Views from floor plans found in the Model list.
Presentation Views provide a top-down view of the drawing in
3D and can be generated in any of SoftPlan’s 3D modes.
Similar to other 3D views in SoftPlan, Presentation Views can
be saved as SoftPlan drawings and detailed with paint and
construction notes. Presentation Views can also be added to
Plan Set Pages and printed along with your other floor plans,
3D images, and construction drawings.

HDR Tone Mapping

When the Tonal Mapping option is checked,
SoftPlan uses an HDR (High Dynamic Range) to
perform more detailed lighting calculations and
then applies Tonal Mapping techniques to convert
that image to one appropriate for display on
computer monitors and printing. This causes
images that would normally appear washed out to
have more pleasing lighting variations.

Gamma Correction

Gamma correction is a technique used to correct
the way images display on monitors. When
applied, it yields a brighter looking image.

Indirect Lighting

Indirect Lighting is light that reflects off
surfaces onto surrounding objects to
produce a more realistic image.

Direct Contribution and Indirect
Contribution sliders allow you to choose
how much direct and indirect light you
want to blend into the final image.
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SoftPlan 2016 Major Features: AutoCAD files to SoftPlan,
SoftPlan 3D to SketchUp
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AutoCAD to SoftPlan Conversion Wizard

The AutoCAD to SoftPlan Conversion Wizard offers an unprecedented level of convenience for importing
DWG and DXF file formats into SoftPlan.

Import a single drawing, multiple drawings, or an entire project by following a series of easy steps to
convert simple lines into walls and other SoftPlan items.

Once you have selected a file to convert, SoftPlan creates a preview tab that automatically updates as
you work. You can then choose which AutoCAD layers to import and how to import them, change wall
lines into the wall types you want to use, cleanup wall generation issues, and convert imported symbols
into SoftPlan symbols and openings.

In minutes, take a “flat” two-dimensional AutoCAD drawing and convert it into a SoftPlan
three-dimensional “BIM” drawing complete with walls, doors, windows and symbols.

B SketchUp

SketchUp Export

With the ability to export models into SketchUp, SoftPlan 2016 offers even more room to realize the
3D presentations you envision while designing.

The quick and simple export process into SketchUp enhances your rendering capabilities by expanding
the modeling options you have at your disposal. With the ease of use of both SoftPlan and SketchUp,
you'll be able to achieve unique renderings with minimal effort.

* SketchUp Export is only available to SoftPlan+ subscribers.
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SoftPlan 2016 Major Features: Elevations and Cross Sections
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Auto Paint Elevations, Interior Elevations & Cross Sections

Elevations can be automatically painted with textures used on the 3D model. The textures used on the
3D model can also be added to Interior Elevations and Cross Sections.

This one-click process gives your drawings the finished, professional look of colored construction
documents and prevents you from taking time to paint individual sections.

Texture opacity can be edited to show more or less of the paint pattern. Changes made to the 3D
model can be easily updated on elevation drawings and vice versa.

SoftPlan’s model paint will put your color printer to use producing better looking, easier-to-understand
drawings in less time.

Automatic Shadows

The new elevation tools can also be used to
isolate the shadows from the 3D model and
add them to an otherwise vector drawing.

This feature will be particularly useful for
those of you that are required to supply sun
study drawings as part of the drawing set.

Auto Label Tops and Bottoms of Walls

To reduce the time it takes to create s« Topef Plate
finished elevations and sections, &
. . " Project Options : Cross Section Generation
SoftPlan will automatically label the ™ v e Socton ~
) . . = Rough Opening Size [m]
elevation markers that indicate the = s =
bottoms and tops of walls on the E S S
) L7 Top of sudfizer Room Name
various floors of a house. P T lopoirize VAo Label Top
Wall
The labels that are placed (top of F:meu

I
g

wall, top of plate, top of footing...) are
user configurable for each floor
allowing drawings to automatically
label using your nomenclature.

[¥] Auto Label Bottom
Wal

op of

op of Footing

4 . Top of Foundaisn

The extension markers are sized so o P
that a dimension line can be easily e ) 7

L. __Tep of Fosting
added.
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SoftPlan 2016 Major Features: Touch Support, Google Earth,
3Dconnexion Mouse and Dentil Molding

Touch Support

This release introduces
SoftPlan Touch support. With
a touchscreen monitor or
Windows tablet, SoftPlan’s
drawing actions are
completely available at your
fingertips.

Using touchscreen movements such as pan, zoom, and drag and drop, SoftPlan’s touch capabilities
allow you to create content from the convenience of your office or on the go. SoftPlan’s intuitive touch
interface facilitates quick sketching by automatically panning where your finger goes and using drag
and drop item placement.

Google Earth @

Google Earth Export

SoftPlan 2016 allows you to export a
project’s site information, such as
latitude, longitude, and direction of North,
to create a Google Earth file. You can then
open this file in Google Earth to display a
satellite image of the property, create
tours and save specified views as jpeg
images.

* Google Earth Export is only available to SoftPlan+ subscribers.

3Dconnexion 3D Mouse Support

SoftPlan 2016 supports 3Dconnexion® 3D mice. Users can simultaneously
pan, zoom and rotate 2D/3D content while the standard mouse remains free
to select menu items or parts of the model.

14

Dentil Molding

New capabilities added
to the profile tools in
SoftPlan 2016 enable
you to create dentil type
molding that greatly
enhances the realism of
the 3D model.

Dentil molds can be
created for such interior
profiles as crown
molding, chair rails and
crowns on the tops of cabinet runs.

more information at www.softplan.com



SoftPlan 2016 Major Features: Plan Sets

Plan Sets

Plan Sets were introduced in SoftPlan 2014 as a way to provide a convenient,
automated method for arranging and organizing one or more drawings or image
pages for printing. SoftPlan 2016 builds significantly onto this feature making
Plan Sets an even more powerful time-saving tool.

Plan Set Templates

Plan Sets that you create can be saved as templates for future use. Plan Set Template files save the
pages you created for the Plan Set and other attributes you specified such as the page size, border,

watermark, and margins.

The next time you wish to use a similar
arrangement of drawings and pages, simply
recall the template. SoftPlan will automatically
create all of the pages and place the
appropriate drawings for the new project on
the sample page used in the original project.

Quickly swap out template drawings for current
project drawings to expedite the printing
process.

Auto Label

Labels showing Drawing Name and Scale are
automatically added to the Plan Set when a
drawing or view is added. These automatic
labels can be edited for content, font, and size, and can be relocated and turned on or off.

This feature eliminates the need to add a “MAIN FLOOR PLAN” type note to a drawing ever again.
Print

Individual pages and page ranges can be sent to the printer.

Building Options

Multiple Building Options can be displayed on a single plan set. This makes it easy to display a plan
and the options for that plan on the same sheet.

Export

DWG/DXF export added to Plan Set Pages.

Schedules

Revision Schedule and Drawing Schedule (Table of Contents) commands added.

Other Changes:

« 3D Views—Regenerate added to right-click menu « Import Image added
« Draw Select added « Missing drawing notification added

« Crop View command added to right-click menu  « Prefix added to Groups, used in place of the

« Erase Drawing or View added to right-click menu group name when numbering pages

« Export of rotated drawings improved + Printadded to the toolbar

« Font Options added for Drawing Name and » Rename added to right-click menu

Drawing Scale

more information at www.softplan.com




SoftPlan 2016 Detailed Features

3D
« 3D Notes added

1979 Chestnut Avenue

« 3D Zoom Speed option control enhanced

« Adjust added to toolbar

« Animation outputs to .WMV format by default

« Anti-Aliasing levels increased

« Banding can be adjusted

« Camera displays the circular path for Camera

« Clay Model 3D mode added

« Collision detection indicators are easier to see

« Draw Profile 3D preview added

« Draw Select added

« Edit Surface dialog enhanced

Eyeball navigation improved

« File Save Images defaults to .JPG

« Frame Rate added to screen animations as a
way to control playback speed

« Go To Room command allows room selection
with a double-click

« Separate Joist materials added

« Opacity override option added to Face Options,
controls semi-opacity for all surfaces

« Rotate Camera around Focus command added
to the 3D View window

« Rotate Focus around Camera command added
to the 3D View window

« Stairs automatically adjust the Camera and the
Focus so when moving in 3D you effectively walk
up or down the stairs

« Time Stamp option added to Sun Study

« Texture Load renamed to Load Preconfigured
Material

« Texture Scale override added to Face Options

« Turning a material off/on included in Undo/Redo

« Zoom in/out on focus added, hold down right
mouse button while moving via wheel or arrow
keys

Building Options

« Building Options moved under Project Options

« Comment field added

« Current sort order saved

« Dialog size holds session to session

« Groups added

« Items can be included in multiple Building
Options

« Multiple Building Options can be displayed on a
single plan set

« No limit on the number of Building Options

« Pasted items are automatically placed on the
current Building Option

more information at www.softplan.com

Area

. Area Labels added to Visibility options

. Area Labels can be moved

. Printing of shaded areas improved

- Project Information can automatically calculate
the Gross Floor Area

. Round Area to Nearest Unit option added

Beams

« Add Drywall
command
automatically o
wraps beam e
with drywall o G005

- Beams on the §%m
drawing are S e
listed at the B )
top of the
Draw Beam —
dialog -

« Beam Shading
added to _ Corifem]

Visible Items Options

Deflection option added allows beam to be
curved in plan view

Dialog width increased to display full name

Drag & Drop sorting added to Beam Definition
Draw Beam dialog stays on screen so different
Beam Types can be selected without starting the
command again

« Dynamic preview added when drawing/adjusting

Cabinets

« 1/4 Round shape added

« Armstrong manufacturer libraries added

« Cabinet height can be adjusted in 3D, Interior
Elevation and Section

« Countertops can be set to Print by default

« Hardware can be added to center of the door

« Narrow Cabinets (<=21") default to a single
door, Wide cabinets (>21") to a double door

« Select Cabinet layout logic improved

« Shelves can be added to 1/4 and 1/2 round
end cabinets

« Wall
Cabinets, 42
added to
default
heights




Ceilings

« Armstrong manufacturer libraries added

. Ceiling Hole edges look improved in 3D

. Grid and Tile ceilings extract in 3D

. Ceiling will move up and down in 3D and section
« Insulation extracts in the model

- Radius Bulkheads added

Copy

. Distance field added allows items to be precisely
copied

Dimensions & Extensions

- Arrow Style options added to instance level

. Dimension line automatically extends to the first

dimensionable item in each direction

Dimension Options toolbar shortcut available

. Dimension Text added to Repeat Edit

- Edit Dimension requires fewer keystrokes

« Dynamic preview added

. Instance level Dimension Options added to
Walls and Beams

- Placement of dimension numbers when using
Accumulate improved

. Posts have Dimension & Extension options

Distance

. Distance command utilizes Perpendicular Snap
« Grouped items added

« Selection Set items added

« Railing Edge and Post added

Decks

- Decks can reference framing rather than finish
material on a wall

« Dynamic preview added when drawing or
adjusting Deck Beams

. Top of Banding offsets to top of Decking

- Joist Hanger option added

. Posts snap under beams

- Railing Style automatically recalled

- Solid Surface (plywood) option added

. Steel Framing option added

Electrical

« Ceiling and Floor Outlets added

« Connect Texture renamed to Connect Linestyle

« Exit Lights, ceiling and wall added

e “Jumps” added to
the arcs when
Electrical
Connections cross

o Lights automatically
added to a Room

« Wall Lights added

SoftPlan 2016 Detailed Features

File

« Close All command added

« Copy Project command added

« Curved Notes export to AutoCAD .DWG files

« lcons added to tabs for easier identification

» Images added to DWG and DXF exports

« Import path is recalled on subsequent imports

« Google Earth Export added

« Navigation Groups underlined, easier to read

o PDF export command updated

« Remove from Recently Opened List command
added to the right-click of a project

« Search Projects command added

« Send To automatically creates a Bound
Drawings folder for system drawings & details

Floor System

« Beams can display shaded

« Curved Beams (Plan View) added

« Insulation extracts in the model

« Joist Hangers can be made visible in Plan & 3D

« Joist Spacing for First Joist can be different than
other Joist Spacing

« Slab insulation thickness can be specified

« Slabs with recessed edges display a solid line to
indicate the depression

« Subfloor area excludes any holes in subfloor

« Drop Cord Truss added
« Walls above the floor and below the floor system
can be displayed

Interiors

« Assign Color option added to System/Drawing
options

- Interior Labels can be moved

. Finishing options increased to 100

oy i'lV"
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SoftPlan 2016 Detailed Features

Layers Openings
« Comment field added « 8 Patio Doors added to library
« Current sort order saved « Deflection option added to quickly change a
« Dialog size holds session to session window to an arch top
« Pasted items are automatically placed on the « Draw Door Leaf Solid option added
current layer
« Set Distance Between command can access Eagleh,v‘
items in a locked layer RS
Miscellaneous « Eagle library updated
« Drawing Options: Reset to System Options » Garage Door Bucks option added

command added

« Elapsed Time counts for entire project m

« Partial Erase dynamic preview added )

« Miscellaneous Colors assignment replaced with
individual settings for: Truss Set, Table, Truss, ~ * Integrity All Ultrex Round Top libraries added
Bridging, Profile Post, Profile Wall, Profile Beam,
Profile Opening, Rafter, Drawing Item Hole, Ref
Point In Symbol, Ceiling, and Profile Zero Line

« Rod & Shelf, Center Panel option added

J‘INDO'! & DOOII.

« Jeld-Wen Aurora exterior doors, Custom Wood
Multi Drawings Contemporary doors, Custom Wood Entry doors

« Export of rotated drawings improved libraries added

Move m
. Area Labels can be moved LBE

. Center in Room command added

- Center Between Edges command added * Kolbe library updated
« Interior Labels can be moved * Marble Sill Type added
- Rotate Item indicates the center point of the » Niche Opening Type added
rotation « Opening Text Options for Interior vs Exterior are
separate
Notes « Opening Textures improved on thick walls if
« 3D Notes added interior & exterior trim are different materials
« Beam Schedule command added
« Cleanup automatically regenerates a schedule
« Copy & Paste between SoftPlan Tables
(Schedules) and Excel spreadsheets added
« Curved Notes export to AutoCAD .DWG files
« Drop Shadow option added to Tables « Pella Architect Series libraries added
« On screen appearance improved « Plantation Shutters (4 section) Opening
« Pointer Notes default to Detail Note type Treatment added
« Regenerate added to right-click on Schedules « Sills default to a Stool & Apron style
o @pg# Information Stamp added  Solar Heat Gain Coefficient (SHGC) added
« @T#PGS Information Stamp added (total plan « Triangle Window added
set group pages) « Trim on multi-material walls improved
o @#PGS Information Stamp added (total plan set « U-value option added
pages)

« Revision Polygon command added

« Schedule, drag & drop reordering of columns
and rows added

« Table Column width can be increased

« Takeoff Schedule added

« Underline option added to cells in a Table

more information at www.softplan.com



Paint

» Coronado patterns updated

« Opacity option added to Solid Paint

« Paint Break located under Draw > Paint

» Shade Break located under Draw > Paint

» Spline shaped Electrical Connections no
longer block Paint

Posts

« Block, Brick & Concrete textures added to
plan view

« Larger Post Cap Symbols added

Maintain Aspect Ratio option added to Edit

» Offset command applies to Posts

Repeat Edit changes both Height and Offset

Print

» Door Leaf can print solid

« Individual Plan Set pages and page ranges
can be sent to the printer

« Zoom can be used while positioning the
Print window

Railings

» Posts miter to underside of railing

 Post Styles reworked, Flat replaced with No
Post, Corner replaced with Center on Rail,
Flush replaced with Flush to Rail

» Spindles of different styles can alternate on
the same railing

REScheck

» SoftPlan Project Information automatically
added to REScheck

» Solar Heat Gain Coefficient (SHGC) added

» U-value option added

reView

» Email option added to PDF Export

» Export Options are remembered/recalled
for the current session

« Password reset option added

 Previously used email addresses are
stored/recalled for subsequent publication

« PDF imports display in exported file

SoftPlan 2016 Detailed Features

Roof

« Auto Roof improved

« Color override added to Roof in plan view

« Display Roof Outline Dashed added to
Visible Items

« Dutch Gable Overhang value added

« Dynamic preview added

« Frieze Board placement improved

« Solar Panel command added
« Walls can be edited from Roof Mode

Roof Framing

« Drop Cord Truss added

« Counter Brace can be added to a Truss Set
« Gable End Ladder added

« King Post Truss added

« Outriggers added

« Rafter Width option added

« Truss Width option added

Rooms

« Draw Room dialog increased in size

« Font size override added to individual rooms

« Lights automatically added to center of a
Room

« Room Properties dialog increased in size

« Rotate option added, displays label
vertically

more information at www.softplan.com
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SoftPlan 2016 Detailed Features

Shapes & Solids Symbols
» Arrow Size limit increased to 999 « Maintain Aspect Ratio option added to Edit
» Arrow placement on arcs improved « Pen option As Defined added
» Center of arcs display as a non-print item « Preview is larger and clearer
« Linestyle selection added to toolbar for Arrows « Symbol search pane is larger
& Spline Arrows « Symbol Selection dialog remembers/recalls size
» Opacity slider added to solid textured shapes « Symbol previews use menu color as a
and solids allowing them to display shaded background for higher contrast
 Polygons can contain both Spline sections and « Symbol Tags added
straight sections « Slopes with Reference option added—causes
» Polygons Undo one segment at a time symbols to follow the plane they are sitting on

« Snap point added at intersection of two circles . .
PP Symbol Libraries

Site « Air Conditioner-wall hung added

» 4’ tall fence definitions added « Opening Jamb details added

» Fences fit to Site Grades with a negative offset « Paint added to plant, tree, shrub & vegetation
» Fence Gate width option added 2D symbols

« Shot Points can be extensioned & dimensioned
» Snap point added at Wall/Site Line intersections

SoftList

» Banding Material added

« Ceiling Perimeter variable added

» Gable End Frieze added

» Gable Vent Trim added

» Opening groups aluminum_sill & marble_sill
added

» Project Information can be automatically added
to the top of a report

» Roof Areas at different pitches will report
separate areas

« Site group fences count « High Surface Count trees added

» Subfloor Area excludes holes for Stairs

« Stair group deck_finish added

» User Defined Variables can be specified as a list

« Valley Sleepers added

« Variables added for wall inside/outside corners

Symbol Manufacturer Libraries

« Benito children's play sets added
« Osborne Wood Products pilasters, panels,
corbels and brackets added

Stairs

» 42" wide stairs added to libraries

« Closed Stringers display in plan view
» Head Clearance defaults to 6'-8”

» Pen Settings
added
Railings can
extend past P
the Post § O
Risers can be
automatically

« Thermador refrigerators, coffee makers,

numbered in cooktops, dishwashers, freezers, microwaves,

plan view ovens, ranges, range tops, ventilation, warming
» Round Nosing drawers, wine columns added

possible with plumb riser « True appliances added

» Spindles can extend down lower than the treads « WindsorOne millwork added
« Stringer Width option added

more information at www.softplan.com



SoftPlan+ Symbol Libraries

» Armchair added

» Bathroom Accessories: metal shelves & towel
bars added

Bunk bed added

Chairs added

» Contemporary Coffee Tables added

» End Tables added

Exterior Lights added

Exercise Bench added

High Surface Count Trees added

Kitchen Accessories, teapot added

Loveseats added

Office Furniture, shelving added

Outdoor Furniture, chair, bench, chaise lounges
added

Televisions added

« Room: Bathroom added

« Room: Bedroom 5 arrangements added

« Room: Dining 3 arrangements added

« Room: Office added

SoftPlan+ Manufacturers Content

« Barlinek hardwood flooring added

» Knoll barstools, chairs, tables, lounge seating,
office seating and café seating added

« Johnsonite flooring added

« Sloan hand dryers added

« TruStile doors added

» Trex decking added

Tools

» Adjust, dynamic preview added
» Extend acts on items within a Selection Set
 Trim - dynamic preview added

Type Erase

» Drawings in Model option added, removes items
from all floors in the model
« Revision Clouds added

SoftPlan 2016 Detailed Features

Walls

« Board & Batton siding will fit to Soffit

« Corner Boards added to Board & Batten walls

« Drag & Drop sort added to Wall Definition dialog

Draw Wall dialog stays on screen so different

Wall Types can be selected without starting the

command again

Dialog width increased to display full name

« Drywall automatically caps the exposed end of
an interior wall if displayed in plan

o Dynamic preview added when drawing or

adjusting Walls

Footings added separately to Visible Items

« Footing can be dimensioned

Frieze Board placement on walls with small jogs

improved

« Wall Insulation extracts in the model

« Glass Block wall added to Extended Wall List

« Log Wall joins improved

« Textures (plan) double-line and long short added

« Quoins run continuous from floor to floor on the

3D model

Walls on the drawing are listed at the top of the

Draw Wall dialog

Wall Framing

« A single Wall Panel drawing can be generated
for all floors in the house

« Blocking on Double Stud walls improved

« Color assignments added for individual framing
components

« Double Window Sill Plate option added

« Framed wall glass wall intersections improved

» Garage Door Bucks option added

» Separate default Styles added for bearing and
non-bearing walls

» Shear Panels added

« “U” corner frame style added

Zoom

« Zoom Center & Corner shading indicator added

« Double-clicking the middle mouse button
performs a Zoom Extent

« Undo includes the zoom state

SoftPlan+ 9

« Custom Symbols and Textures used in a project
automatically backup to the SoftPlan+ server

« Status indicator added when accessing the
SoftPlan+ server

« email address added under Project Information
automatically lists as email address when
publishing

more information at www.softplan.com
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SoftPlan+ cloud drive and services

SoftPlan+ is a subscription-based approach to using SoftPlan that enriches the design process by
providing the user with a suite of cloud services and up-to-date knowledge of everything SoftPlan has
to offer.

Take advantage of complimentary upgrades, enhanced technical support, access to exclusive content,
the complete training library, and the SoftPlan+ online cloud drive that makes sharing your projects
across multiple locations easier.

Cloud Sharing

SoftPlan+ saves the most recent copies of your projects to the 1
SoftPlan+ cloud drive. With your SoftPlan key and a high speed
internet connection, you can continue to work on your project
from a different system installed with SoftPlan.

The new SoftPlan reView extensions also allow you to publish
your documents for customer viewing, including 2D vector
drawings and rendered panoramic views. Customers can also
make notes on the vector drawings and any changes appear
automatically the next time you open the project.

Current SoftPlan Version

Never pay for an upgrade again. SoftPlan+ subscribers have no-cost access to the latest version
SoftPlan has to offer. Receive all of SoftPlan’s time-saving enhancements as soon as an updated
version is released.

Toll Free Technical Support Number

Reach SoftPlan’s technical support team with the SoftPlan+ toll free number to receive personalized
assistance.

Integrated Support Tickets

SoftPlan+ includes the ability to submit support tickets directly through the SoftPlan+ interface.
SoftPlan then gathers all the files of your project and makes a copy available to the SoftPlan support
staff who can then review your project and provide the appropriate feedback and files you need to
address the issue.

Command and Control Support

With permission, SoftPlan+ support technicians have the ability to take control of a SoftPlan+
subscriber’'s computer for advanced assistance.

Command and control support sessions are initiated at the discretion of the technician.
All SoftPlan+ features require a high speed internet connection.

BORALJ .
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SoftPlan+ cloud drive and services

Customer Interaction

SoftPlan+ strengthens the
collaborative process of

designing a house by allowing

you to publish 2D plans and 3D models
that the customer can view from

a PC, android, or iOS device of

their choice. Always keep your
customers up to date.

reView

All reView functionality is

available through SoftPlan+

including the authoring of reView & PDF
files.

Panorama Views

Automatically generate panoramic views from predefined points to create a fully immersive 3D
experience on PC, iPad, iPhone, or android devices.

iOS and android support

SoftPlan+ supports Apple iOS and android devices so that your work can be accessed from anywhere.
Using a free viewer app, the people you share with can mark up drawings, add notes, and take virtual
tours of a house in full, panoramic 3D, all from the convenience of their iOS or android device.

Online Training Content

SoftPlan+ provides full online access to the complete training library with over 160 step-by-step
tutorials. New content that is added to the training library becomes immediately available to SoftPlan+
subscribers.

O O O

Premium Content

SoftPlan+ subscribers have access to additional content that is stored on the SoftPlan+ cloud server.
SoftPlan may augment these offerings at any time.

Enhanced Libraries

SoftPlan+ symbol libraries include new libraries of Kitchen Accessories, Beds, Stools, Lights,
Office Furniture, Range Hoods, Chaise Interior Décor, Tables, Dressers, Wardrobes,
Entertainment Consoles, Credenzas, Sectionals, Benches, Ottomans, Vehicles, Bathroom
Furniture and much more.

)

Enhanced Textures

SoftPlan+ texture libraries include enhanced entries and manufacturer offerings including
some from the manufacturers listed below.

Product names, logos, brands and other trademarks referred to within SoftPlan Systems, Inc.’s products, services
and within this brochure are the property of their respective trademark holders.

o BUZO — ZIENN-AR

n (© caesarstone
Villeroy & Boch

Miele) AVONITE LIOLF] Room&Board
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